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About the Release Notes

These release notes describe the issues that have been fixed for JMP 8.0.2. For the JMP 8.0.1 
release notes, see http://www.jmp.com/support/downloads/jmp_software_updates.shtml.

Analyze Menu

Distribution

• If you fit a smooth curve, or if you fit a smooth curve and save a density formula, JMP no 
longer quits unexpectedly.

• If the data includes missing or negative weights or frequencies, the following features now 
correctly handle the data: 

• A Poisson fit with missing observations no longer results in a missing log likelihood.

• The CPM confidence interval calculations are now correct.

• If you specify the Fix Parameters option for theta, the three parameter Weibull fit is now 
correct.

• For data with a y value equal to zero, the exponential fit is now available.

• If you use the hand tool to modify histogram bars, then you use the Set Bin Width option, the 
axis values and histogram bars are now updated.

• If you turn on Automatic Recalc, and then change the data values in the data table, the 
statistics and graphs are now updated automatically.

• If you specify a frequency and a weight, and there is at least one row with a weight value of 
zero, capability confidence intervals are now correct.

• If you have large frequency values, a Goodness of Fit test now results in a warning message, 
and JMP no longer freezes.

• When you fit the threshold Weibull distribution, the confidence limits now match correctly.

– Normal fit
– Smooth Curve fit
– Gamma Poisson fit
– Gamma fit
– Poisson fit
– Beta Binomial fit

– Exponential fit
– Beta distribution
– Signed Rank Test
– Confidence Intervals
– Capability Analysis
– AICc


http://www.jmp.com/support/downloads/jmp_software_updates.shtml

http://www.jmp.com/support/downloads/jmp_software_updates.shtml
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Fit Y by X

• If the Automatic Recalc option is turned on, the option is now saved to script.

Oneway

• In JSL, if the Power Plot option is requested along with either of these options: Solve for Least 
Significant Number or Solve for Least Significant Value, JMP no longer quits unexpectedly.

• The Matching Column message to Oneway now accepts a column number (as well as a name 
argument) as an argument in a script.

Logistic

• If you try to request a logistic analysis on a data table that has all of its rows excluded, JMP 
now produces an error, and no analysis is performed.

Fit Model

• If you include a Where clause, the Save Script to Data Table command now saves the script to 
the active data table, instead of saving the script to a hidden data table.

Generalized Linear Model

• In a script, if you specify the Term Value, Desirability Functions, and Maximize Desirability as 
Profiler options, these options are no longer ignored when you submit the script.

• Effect tests are now correct for the Firth estimation method.

REML and Mixed Models

• When you save confidence intervals from REML analyses to the data table, JMP no longer 
ignores the specified alpha level if it is different from the default value of 0.05.

Modeling

Screening

• An error message now appears when you specify the same variable for Y and X.

Nonlinear

• Within the Model Library, the Bioassay 5PL grouped starting value routine now works for 
data sets with 0,1 response.

• If you turn off the plot, save the script to the script window, and re-run the script, the plot 
now disappears.

• Second derivatives now work if you specify them outside of the launch window.

• Setting local variables no longer gives you an error message.

Neural Net

• If you run a sequence of fits for data containing a penalty value, the results for the penalty are 
now correct when you move between the fits.
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Gaussian Process

• The sensitivity analysis for the cubic correlation function is now correct.

Partition

• The Go button now appears reliably, even when you exclude fewer than 20 percent of the 
rows.

• When you run a script with a large number of initial splits and a non-default value for 
Minimum Split Size, JMP no longer quits unexpectedly.

Time Series

• The results of no-differencing ARIMA models no longer depend on the order of the models.

Choice

• Effect tests are now correct for the Firth estimation method.

• On the Macintosh, if you execute the Model Dialog command from a Choice report, and 
then click in the File menu, JMP no longer quits unexpectedly.

• For a one-table analysis, the Save Script to Table option is no longer grayed out.

Multivariate Methods

Multivariate

• If the data table has missing values on every row, the REML results are no longer different 
from SAS.

• For the Pairwise and Rowwise methods, when the Multivariate Simple Statistics is selected, 
degrees of freedom are no longer negative. Also, the Multivariate Simple Statistics option is no 
longer selectable with the Pairwise method.

• If you are analyzing significant amounts of data using the REML estimation method, the 
Multivariate and the Principal Component platforms no longer cause JMP to freeze.

• The Mahalanobis distance is now computed correctly when added to a data table with 
missing values.

• For the rowwise estimation method, the Impute Missing Values option is not applicable, and 
is now grayed out and inaccessible.

• The mean is now correctly computed when a linear dependency is detected among the 
variables.
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Cluster

• For categorical terms, the Fast Ward clustering method no longer causes JMP to quit 
unexpectedly.

• The Save Clusters option now saves the correct number of clusters in the data table when 
missing values or excluded rows exist.

• K-means clustering no longer selects the same initial seeds, regardless of whether the 
Standardize Data option is turned on or off.

• In hierarchical clustering, the color map legend is no longer missing labels.

• Zooming excessively in the dendrogram no longer causes JMP to quit unexpectedly.

• The Two Way hierarchical cluster no longer shows markers at the bottom of column 
dendrogram labels.

Discriminant

• On the Macintosh, the PNG graphics saved for a 3D canonical plot are no longer blank.

PLS

• When you turn off the Show Points option (hiding the points) and then close the report 
window, JMP no longer quits unexpectedly.

• When input columns are constant with centering and scaling turned on, the generated 
predictions no longer contain missing values.

Reliability and Survival

• In the Life Distribution and Survival platforms, interval censored data that uses Turnbull 
estimates no longer causes incorrect time intervals in a survival plot, a failure plot, and a table.

• If the survival rate of S(t) is equal to a percent during a time interval, the Quantiles point 
estimates are now correct.

• The upper confidence interval for the median now follows Brookmeyer and Crowley (in JMP 
8.0 and JMP 8.0.1, it followed Klein and Moeschberger).

• The WeiBayes confidence interval on an estimated quantile is now an appropriate width.

• In Exponential distribution, the theta value is no longer missing if you fix it to a specified 
value, and no convergence warning appears.

• For a Weibayes analysis, the point estimates and confidence intervals for scale parameters are 
no longer missing.

• In the Survival platform, if you fit exponential distributions for data sets with many right-
censored values, then you select Estimate Survival Probability and/or Estimate Time Quantile, 
the standard errors and the confidence intervals that are outputted for exponential 
distributions are now correct.
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Life Distribution

• The Show Likelihood Contour option is now saved to the script.

• In an event plot, the horizontal lines no longer disappear when you select the Log Scale 
option from the x-axis.

• In an event plot, Frequency text was unreadable. Now, you can use the Show Event Plot 
Frequency Label option to hide or show Frequency text.

• In an event plot, horizontal lines are no longer drawn for hidden rows.

• In the Distribution Profiler and the Quantile Profiler, if you select the Profile option for the 
Confidence Interval Method, the confidence internal curves for generalized gamma and log 
generalized gamma are now correct.

• Confidence intervals for cumulative distribution functions (CDF) of threshold (TH) 
distributions are no longer bent (they now increase monotonically).

• In the Life Distribution and Fit Life by X platforms, if you change the probability scale of the 
probability plot, the minimum and maximum values no longer change.

• In the Parametric Estimate - Exponential red triangle menu, if you select Save Probability 
Estimates and/or Save Quantile Estimates, the confidence intervals that are saved for 
exponential distributions are now correct.

Fit Life by X

• For a model with a Weibull distribution, the values for alpha and beta are now added to the 
“Separate Location” and “Separate Location and Scale” results.

• If there are many censored observations in a Cox-Snell P-P plot, the axis ranges now fit.

• Excluded rows now appear in the scatterplot.

• For interval censoring, hidden rows are no longer incorrectly reflected in the scatterplot by 
vertical lines.

• If you perform a Fit All Distributions, the models in the Comparison Criterion tab are now 
sorted by the log likelihood.

• On the Comparison Criterion tab, if the number of non-censored values within a group 
equals zero or one, the AICc and BIC values are now correct.

• If the predictor is categorical, the default relationship is now “Saturated Location and Scale” 
instead of “No Effect”.

• Multiple probability plots for Fit Life by X regressions now contain baselines.

• The initial Nonparametric Overlay plot no longer has too much white space at the top and 
bottom.

• Frequency values of zero no longer cause JMP to quit unexpectedly.

• Scrolling no longer causes JMP to quit unexpectedly when the number of groups is large.

• For the Hazard and Density profilers, the confidence interval values no longer appear.



Release Notes for JMP 8.0.2

Page 7

Fit Parametric Survival

• If the number of rows is more than several thousand, the computation time is now faster.

• For an Exponential distribution, the values for -2 loglikelihood, AICc, and BIC are now 
correct.

• For an Exponential distribution, the P-values under “Whole Model Test” and “Effect 
Likelihood Ratio Tests” are now correct.

Custom Menus and Toolbars
• Exporting the top-level toolbar now includes JSL dependencies.

Data Tables
• Data table rows now refresh when you use the scroll wheel on the mouse.

• If you create a table variable and a table property/script with the same name, and then you try 
to edit the table script, JMP no longer quits unexpectedly.

• If a table property and a table variable have the same name, and you delete one of them, JMP 
no longer quits unexpectedly.

Column Properties

• When you are creating a column or changing the format of a column using JSL, the field 
width is automatically adjusted. As a result, the field is now wide enough to show the cell 
value using the format you specify.

• If a column contains all missing values, the Color or Mark by Column option no longer causes 
JMP to quit unexpectedly.

• If you use JSL to join tables by matching columns, and you do not specify which columns to 
match, JMP no longer quits unexpectedly.

Data Filter

• If you issue the JSL Quit command while the Data Filter is open, JMP no longer quits 
unexpectedly.

Finding Data

• If you search for numeric columns with alphabetic characters in a formatted string, JMP now 
finds the alphabetic characters. Previously, if you searched for value labels or formatted values 
with the Match Case option unchecked, the option did not work correctly.
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Formula Editor

• Within a script, if you execute the Run Formulas command on a data table that does not 
contain any formulas, JMP no longer quits unexpectedly.

• On the Macintosh, if you delete a value in a formula using the delete key, then, type in 
another value and try to delete the value a second time using the delete key, delete now works 
properly.

• On the Macintosh, if you apply a faulty formula, you now get an error message.

• Parameter hints have been added for the Johnson SI functions.

• If you have formulas with circular dependencies (for example, column A depends on column 
B, which depends on column A) the associated error messages and dialogs have been 
improved and simplified.

Tables Menu

Summary

• If you add a quantile to a Summary table that contains subgroups, JMP no longer quits 
unexpectedly.

Subset

• If you link a data table subset to the parent table, the tables properties and scripts are now 
copied to the subsetted table.

Join

• You can now select Row State columns for output, and use Row State columns as matching 
columns. 

Tabulate

• If you have already defined statistics in a column table, and you try to add statistics to a row 
table, the results are now accurate. The same problem occurred for analysis columns and is 
also fixed.

• If you build a table using Dialog, the statistics you use to build the table are now the same as 
the statistics you specified in the Dialog.

• If you change the format of statistics in a column, the changed format is now remembered. 
When you re-do the analysis, JMP uses the updated format.

• You can now add more than one percent of the total statistic to a table.
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Data Visualization
• In a Mousetrap command, if you try to close the window after a mouseclick, JMP no longer 

quits unexpectedly.

Design of Experiments
• The default number of runs and the minimum number of runs is now correctly calculated for 

designs with hard to change factors, designs with random blocks, blocked designs, and Scheffé 
Cubic models.

Custom Design

• If you add center points and replicates, the design diagnostics are now updated.

• If you add an uncontrolled factor to a custom design, when you make the design, JMP no 
longer quits unexpectedly.

• If you enter a bound constraint as a linear inequality constraint, the design now respects the 
bound constraint.

• The Mixture Sum window contained two Edit boxes. The Edit box that asks you to choose a 
number greater than zero for the non-constant mixture components is unnecessary and has 
been removed.

• Design diagnostics are now correct for replicated block designs.

• The Mixture Sum command is now automatically saved with the Save Script to Script Window 
option and the DOE dialog.

• If design constraints are inconsistent, you now get an error message.

• When creating a design using JSL, the Mixture Sum command is now respected.

• When creating a custom design, the Search Points Per Factor value is no longer ignored.

• When creating a custom design, linear constraints that are equivalent to bound constraints no 
longer change to zeros.

• If you specify the Mixture Sum as the same value twice, the effect limits are no longer updated 
unnecessarily.

• D-optimal mixture designs with no constraints now provide designs with factor values that 
have less fixed width.

• The Save Constraints option now creates a constraints data table.

• Constrained designs with covariates no longer result in invalid values or cause JMP to quit 
unexpectedly.

• Designs containing an uncontrolled factor and constraints no longer cause JMP to quit 
unexpectedly.

• I-optimal designs with the sphere radius option no longer cause JMP to quit unexpectedly.
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• Designs containing many mixture factors with upper bounds that are less than the Mixture 
Sum no longer cause JMP to hang.

• If a design could potentially be singular due to disallowed combinations, you get a warning 
message.

• Replicating a blocked design and closing the Custom Design window no longer causes JMP 
to quit unexpectedly.

• The D-efficiency in the Design Diagnostics section now matches the D-efficiency of the final, 
created design.

• If you create a design with a constant factor and save the script, the resulting script is now 
correct, and the constant factor is no longer changed to “continuous”.

• Easy to change categorical factors are now randomized.

• If your factor table contains numeric categorical factors, and you load the table into the 
Custom Design platform, the factor levels now use the actual factor levels rather than the 
reference levels.

• If you use the Back button to create D-optimal RSM designs with the sphere radius option, 
or RSM designs, the diagnostic information is now correct.

• If you try to remove model terms without using the Back button, JMP no longer quits 
unexpectedly.

• If you create a design using JSL, and you specify the Number of Starts and Add Term 
values, they are now respected.

• For designs that involve covariates, if you make the design and click Make Table, the design 
diagnostics are now correct and do not change.

• In any localized version of JMP, if you check the Save Scripts in English option in the General 
Preferences window, the scripts generated by Custom Design are now saved in English.

• For strip plot designs, the subplots are now allocated correctly.

• Bayesian D-optimal split plot designs are now generated correctly.

Screening Design

• If you choose the 104 run Plackett-Burman Folded design, JMP no longer quits unexpectedly.

Mixture Design

• If you change the Mixture Sum option, the Factor Settings table now updates automatically.

Choice Design

• All choice sets now produce different product options, and no redundant options appear.

Taguchi Arrays

• The Response Goal text box is now large enough to view the entire content.
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Augment Design

• If the design contains mixture factors, the constraints are now loaded correctly.

• Greater than or equal to constraints are now correctly imported, and you no longer get an 
inappropriate error message.

• When the initial design is singular (due to added model terms) or when a non-singular 
starting design is encountered, JMP no longer gives you an error message.

• If you press the Back button, the suggested number of runs no longer changes.

• If you add model terms to a block design, JMP no longer produces incorrect designs or 
unexpectedly quits.

• In response surface and screening designs, if you change the name of the block column, JMP 
no longer quits unexpectedly, or produces results with missing values, or produces an 
incorrect design.

• If you select the Group new runs into separate block check box, and then click Augment, the 
option now remains checked.

• It is no longer possible to load factors into the Augment platform which would result in a 
crash.

• If you use the Save X Matrix option in conjunction with Replicate, Add Centerpoints, Fold 
Over, or Add Axial, JMP no longer quits unexpectedly.

• If you augment a block design and then press the Back button, JMP no longer produces an 
incorrect design, or quits unexpectedly.

Sample Size and Power

• The sample size calculator now does power and sample size computations for one-sided and 
two-sided tests, for both one sample and two sample proportions. The computations are done 
using exact methods based on binomial distribution.

Display
• Large marker sizes no longer obscure labels.

• Dialogs are no longer broken by cutting, deleting, and pasting text into the wrong place.

• Changing the scale from Linear to Log no longer causes points to disappear from the 
scatterplot.

• In the Color or Mark by Column window, the following changes have been made: 

– The Colors submenu is now active.
– Custom colors are now implemented correctly.
– Custom colors are now applied to rows.
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Graph Menu

Graph Builder

• The chosen ranges for the Wrap values of ordinal variables is now appropriate.

• If you copy and paste a graph containing Group Y labels, the labels no longer wrap and are 
fully visible.

• If you click and drag multiple columns of nominal data with many levels into Graph Builder, 
JMP no longer runs out of memory.

• A plot with a single, categorical variable no longer produces a meaningless visual.

• If your data contains multiple Y variables, changing the bar style to Stacked no longer causes 
JMP to quit unexpectedly.

• Graph Builder now launches correctly from the JMP Starter window.

Chart

• When you try to combine a line chart and error bars, the Add Error Bars to Mean option is 
now enabled for line charts.

• If you click on a bar that contains blank label values, JMP no longer quits unexpectedly.

Bubble Plot

• When grouping exists, time labels are no longer cut off and partially hidden.

• If you have not specified a Time variable, and you select the Trail Lines option, JMP no longer 
quits unexpectedly.

• If you save a bubble plot as a Flash file (SWF), the resulting file no longer contains incorrect 
labels on the log scale.

• If a bubble plot contains two ID columns and you modify the first one, and then you split a 
bubble and click on it, JMP no longer quits unexpectedly.

• In Flash output, you can now select bubbles whose edges are clipped by the plot axes.

• If you select the Label all bubbles option, the labels now remain when you zoom in or out.

• If a Flash bubble plot animation is playing, selecting the Reset option now stops the 
animation.

Cell Plot

• For missing values, colors are now assigned the appropriate color (white).

Tree Map

• Initially excluded rows no longer lose their color and appear white when unexcluded.



Release Notes for JMP 8.0.2

Page 13

Control Chart

• In EWMA charts, Westgard Rules no longer trigger too frequently.

• When creating a control chart using JSL, the argument Empty( ) is now accepted for the 
Sample Label command.

• For Levey Jennings charts, you can now import control limits from a saved data table.

• In the Presummarize Chart, the capability analysis now computes the correct value for the 
standard deviation.

Multivariate Control Chart

• If you turn off the Change-Point Detection option, the associated scatterplot matrix now 
disappears.

Variability/Gauge Chart

• The borders around the Variability Chart tick labels that cross the border can now be 
adjusted.

Capability

• If you use JSL to specify the Import Spec Limits command, you no longer get an error 
message, and the specification limits are imported correctly.

• The Capability script now captures the Frequency or the Weight variables.

Profiler

• The Flash profiler no longer shows an extra, inappropriate level for categorical factors.

• Optimization now works when constraints and several locked variables are present.

• You can now prevent formulas from being expanded by setting the Expand Formula column 
property to zero.

• If you set a factor value that is not within the current axis range, the value is no longer 
ignored. Instead, the axis range is now adjusted.

• Confidence intervals are now consistent between the Fit Model platform and saved formulas.

• In Flash output, the behavior of the Reset option is identical, whether you select Reset from 
the blue triangle menu, or if you right-click outside of the axis areas and select Reset.

• The Flash Profiler has improved support for log scale axes.

Profiler Simulator

• Running the Simulate command from a script no longer causes JMP to quit unexpectedly. 
JMP was running out of memory when creating an inappropriate table that was too large.

• If you select and copy the Profiler and the Simulator, you no longer get an error, and JMP 
does not quit unexpectedly.

• If you have input factors with the Fixed specification, they are now sequenced to the 
simulation table.



Release Notes for JMP 8.0.2

Page 14

Surface Plot

• On the Macintosh, the Save Picture command now works for these formats: Native, JPEG, or 
PNG.

• If you try to journal a DisplayBox that does not support journaling, JMP no longer quits 
unexpectedly.

Importing and Exporting Data

Importing Data

• If you import a text file using Data with Preview, any missing columns no longer have an 
invalid numeric format. If you then save the table as a SAS data set, you no longer get an 
error.

• On Linux, icons are no longer missing for column names.

• On the Macintosh, clicking on the column name now allows you to edit it.

• The Text Import window now previews (and continues to import) quoted column delimiters 
(typically, commas or tabs) as a single column.

• If you import a CSV file, the Recognize apostrophe as quotation mark text import preference 
is now honored.

Exporting Data

• If you copy a histogram to a journal or to an external program, the data values and the axis 
information are now correct.

Excel

• In the Save File As window, if you save an Excel file and do not specify the extension (.xls or 
.xlsb), you no longer get error messages, and the file saves correctly.

• In JMP, if you try to open an Excel file that is already open in Excel, JMP can now open it.

• If you copy and paste empty cells from Excel into JMP, they no longer overwrite JMP cell 
values and show as missing.

Journals
• If you create a journal with a check box that has a list of strings, JMP no longer quits 

unexpectedly.

• If you create a journal containing graphs with customized font information, you no longer 
receive an error when you try to re-open the journal.

• If you add a text item to a journal, then click and drag it under the Tabulate outline, it no 
longer disappears.
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• If you have multiple graphs in a journal that were created using Graph Builder, if you try to 
delete them, now all of the graphs can be deleted.

• Bullet point text items now use the text highlight color, making them easier to read.

• If you save and re-open a journal that contains box plots in the legend, JMP no longer 
produces an error.

• If your graph contains ref lines that are not labeled, and you save the graph to a journal and 
re-open it, the ref lines continue to be unlabeled.

Linux
• The Linux installer Web viewer now displays GIF or JPG files.

• The Linux manual activation web page now shows the correct version and complete text.

• The function of checking the location of a JMP.per file no longer incorrectly prompts you to 
navigate to the location of the .per file.

• Within various menu options, icons are no longer missing or incorrect.

• After applying preferences, if you open the View menu, JMP no longer quits unexpectedly.

• JMP 8.0.2 can now be installed in a custom location.

• JMP 8.0.2 can now be installed on 64-bit Linux.

• JMP installation no longer fails or conflicts with other system applications, due to shared 
library problems.

• The crosshairs, lasso, and brush tools now work.

Macintosh
• In the Column Info window, if you select the Value Labels option from the Column 

Properties menu, when you enter the Value and Label data and press Return, the window no 
longer closes, and correctly adds the entries to the list.

• The File > Page Setup window now listens to user input.

• The following toolbar icons are no longer missing in all languages except English: Window 
Tools, Graph Tools, and Annotation Tools.

• The About JMP window now shows license information, including company name, site 
number, and expiration date.

• When you open a file, you can now access directories whose names contain periods.

• When you open an auto-run script, you no longer see a bogus alert.

• When you apply a new license text file (SID) the browser window now allows you to select it.

• If you use a forward slash (/) in a file or pathname, JMP can now find and access the file.

• Within a script, if you specify Open( ) to open and browse a CSV file, the file opens 
correctly, and you no longer get an error message.
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• Group Y labels now display completely and the text is no longer hidden.

• If your data tables contain Japanese data and were created using JMP 5.1, and you try to open 
them, they now open correctly with no missing data.

• If a progress window appears, you cannot close any critical operations or adversely affect the 
operation whose progress is being monitored.

• During Multivariate Item Analysis, JMP no longer quits unexpectedly.

• The JSL command Quit(NoSave) now works correctly.

• This folder now has the correct permissions, and users who are not the owner can read the 
files within it:
Library/Application Support/JMP/8

• On the Macintosh, if you download a trial version of JMP 8.0.2, a registration window no 
longer appears mistakenly after activation.

Preferences
• For the Life Distribution and the Fit Life by X platforms, the Censor Code preference option 

is now honored by the launch window.

Printing
• Printing out a long data table no longer truncates the bottom portion of the page numbers.

• In the Japanese version, when you print categorical data values for a horizontal axis, the values 
no longer disappear.

SAS Integration
• From a SAS 9.1.3 stored process, you can now select multiple items from a list with more 30 

total items.

• On Linux, when you save SAS Program Files, the correct file type now exists (.sas). SAS 
Program Files also now have the SAS code coloring.

• You can now open SAS Output windows and SAS Log windows on Linux.

• On the Macintosh, the GetSASLog command with the OnError option now works correctly.

• If you are using SAS ODS XML formatting, you no longer see missing values.



Release Notes for JMP 8.0.2

Page 17

• The SAS integration connection now works for a group identity.

• If you terminate asynchronous SAS sessions, JMP no longer quits unexpectedly.

• If commands are sent to a SAS connection after a submit has been canceled, JMP no longer 
quits unexpectedly.

Scripting
• You can now use JSL to check for a named data table without JSL forcing a prompt to open a 

table if that table is not found.

• If you run a script that you have saved to a data table, or if you have a continuous By group 
that contains missing values, you no longer get an error. JMP was using the = operator instead 
of the IsMissing() function.

• If you launch the Fit Model platform using JSL, you can now modify the data table using JSL.

• On Linux, the Window( ) function no longer returns an empty list.

• Messages sent to a Fit Model object now work even when the original data table used to create 
the Fit Model object is no longer the current data table.

• RadioButtons no longer ignore missing values or return incorrect values.

• For a DOE dialog script, Run Script now works correctly.

• For elementwise matrix multiplication, you no longer get matrix conformance errors due to 
JSL parsing issues.

• The log10(x) JSL function is more accurate in the last bit. For small integers, k is now 
exactly equal to log10 (10^k).

• Subscripting by an empty matrix now returns an empty matrix instead of an error result.

• When the JSL scheduler is idle, the CPU usage is no longer 50 percent or higher.

• If you select items in a list box using the keyboard, the associated script now executes properly.

• In a custom column list box, if you click in the white space, the script argument is now 
executed.

• In the Formula Editor window, there are now hints for the arguments of the Random Johnson 
SI function.

• If you try to access a column list box that was created from a data table that is closed, JMP no 
longer quits unexpectedly.

• If you manipulate expressions, or use certain functions that produce expressions (such as 
derivative), the expressions now generate a correctly parenthesized text representation.

• Multiple updates to OpenGLDisplay no longer cause JMP to quit unexpectedly.

Automation

• Within a data table, you can now specify the currency symbol for each column of data.

• The InsertDataVector command now inserts all data at the beginning and end of rows.
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Windows
• In Finland, if you launch JMP after installation, you no longer get an error that says, “JMP 

has not been installed properly.”

• The first time you run JMP Genomics 4.1, it no longer quits unexpectedly.

• Centered and rotated text in metafile and screen output is now generated correctly. There is 
still an issue with pasting using the clipboard of Windows metafile. It is recommended that 
you use enhanced metafile instead.

• When editing a custom menu, if you access the Menu Item Properties window, select the Icon 
tab, click on the Browse button and select your bitmap image, JMP no longer quits 
unexpectedly when you click the Open button.
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